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            lwpuk lgk;d lh/kh HkrhZ ijh{kk 2008 
            ijh{kk iz’u i= 

            
           

1. lh-ih-;w- ls vkidk D;k vfHkizk; gS\ 
A) dUVªksy ,.M izkslsflax ;wfuV   B) lsUVªy izkslsflax ;wfuV 
C) lsUVªy izksVsD’ku ;wfuV    D) dUVªksy ,.M izksVsD’ku ;wfuV 
Ans : (B) 

2. lh-ih-;w- dh xfr fdlesa ekih tkrh gS\ 
A) ckbZV~l      B) fcV~l 
C) fuCcYl      D) gV~Zt 
Ans : (D) 

3. iSjsVh fcV ------------------------------------- 
A) NksVs v{kjksa dks n’kkZrh gSA    B) =qfV dh [kkst djus ds dke vkrh gSA 
C) ckbZV dh igyh fcV n’kkZrh gSA   D) ckbZV dh pkSFkh fcV n’kkZrh gSA 
Ans : (B) 

4. dkSu lk ;U= Nih gqbZ QksVks dks dEI;wVj esa Hkstus ds dke vkrk gS\ 
A) LdSuj      B) ekÅl 
C) dh&cksMZ      D) ekbØksQksu  
Ans : (A) 

5. ,d dEI;wVj izksxzke tks iwjs izksxzke dks e’khuh Hkk”kk esa cnyrk gS] dgykrk gS& 
A) bUVjizsVj      B) flewysVj 
C) dEikbZyj      D) dekaMj  
Ans : (C) 

6. fuEufyf[kr esa ls dkSu lk vkWijsfVax flLVe ugha gS\ 
A) ;wfuDl      B) foUMkst 
C) ikLdy      D) yhuDl   
Ans : (C) 

7. vkWijsfVax flLVe dk D;k dke gS\ 
A) ^lh* Hkk”kk ds izksxzke dks e’khuh Hkk”kk esa cnyukA  
B) ,lsEcyh Hkk”kk ds izksxzke dks e’khuh Hkk”kk esa cnyukA 
C) flLVe ds gkMZos;j vkSj lkW¶Vos;j Hkkxksa dks lEHkkyukA 
D) xzkfQDl cukukA 
Ans : (C) 
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8. ;wfuDl esa ^ih-MCY;w-Mh-* dk vFkZ gS&  
A) fiazV oMZ MkWD;wesaV     B) izstsaV ofdZax Mk;jsDVªh 
C) fizaV fonkÅV MhVsYl    D) ikloMZ 
Ans : (B) 

9. foUMkst esa QkWjesV dk vFkZ gS& 
A) p;fuV QkbZyksa dks fMLV ls MhyhV djukA 
B) p;fuV QksYMjksa dks fMLd ls MhyhV djukA 
C) p;fur MkbZjsDVªht ds lewg dks fMLd ls MhyhV djukA 
D) lHkh QkbZyksa vkSj MkbZjsDVªht dks fMLd ls MhyhV djukA 
Ans : (D) 

10. foUMkst esa ^,e,ldkWufQx* dekaM D;k djrh gS\ 
A) fizaVj dh lsfVax djrh gSA    B) flLVe dks dksafUQxj djrh gSA 
C) csrkj usVodZ lsfVax dks dksafUQxj djrh gSA  D) ekÅl dh lsfVax djrh gSA 
Ans : (B) 

11. dkSu lk lkW¶Vos;j i=] izkFkZuk i= bR;kfn cukus ds dke vkrk gS\ 
A) ikWoj IokbUV     B) oMZ izkslslj 
C) LiszM’khV      D) vkWijsfVax flLVe  
Ans : (B) 

12. ,e-,l- oMZ esa ^dUVªksy $ vkbZ-* D;k dke djsaxs\ 
A) pqus gq, v{kjksa dks cM+s vkdkj esa cnysaxsA  B) vxyh iafDr esa tkus ds fy,A 
C) pqus gq, v{kjksa dks cksYM djus ds fy,A  D) pqus gq, v{kjksa dks Vs<+k ¼bZVsfyd½ djus ds fy,A 
Ans : (D) 

13. ,e-,l- oMZ dh QkbZyksa dh ,DlVsa’ku D;k gksrh gS\ 
A) .dot      B) .doc 
C) .dom      D) .txt 
Ans : (B) 

14. Lisfyax tk¡pus ds fy, buesa ls fdldk iz;ksx gksxk\ 
A) F1      B) F2 
C) F7      D) F9 
Ans : (C) 

15. ,e-,l- oMZ esa ^dUVªksy $ ch* fdl dke vkrk gS\ 
A) pqus ‘kCnksa dks cM+k djus ds fy,A   B) vxyh iafDr esa tkus ds fy,A 
C) pqus ‘kCnksa dks cksYM djus ds fy,A   D) pqus ‘kCnksa dks Vs<+k ¼bZVsfyd½ djus ds fy,A 
Ans : (C) 

16. ekStwnk izLrqrhdj.k ¼-ihihVh QkbZy½ esa ubZ LykbZM Mkyus ds fy, D;k djuk gksxk\ 
A) File, Add a new slide    B) Insert, New slide 
C) File Open     D) File, New 
Ans : (B) 
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17. ekStwnk izLrqrhdj.k ¼-ihihVh QkbZy½ esa ,d ls vf/kd LykbZM~l dks dSls pqusaxs\ 
A) ^vYV* ds lkFk izR;sd LykbZM fDyd djdsA  B) ^f’k¶V* ds lkFk izR;sd LykbZM Msªx djdsA 
C) ^f’k¶V* ds lkFk izR;sd LykbZM dks fDyd djdsA D) ^dUVªksy* ds lkFk izR;sd LykbZM dks fDyd djdsA 
Ans : (D) 

18. gS.M vkÅV~l eas gsMj o QqVj Mkyus ds fy, fdldk iz;ksx gksxk\ 
A) n VkbZVy ekLVj     B) n LykbZM ekLVj 
C) n gS.M vkÅV ekLVj    D) ,Q&cu 
Ans : (B) 

19. ekbØkslkW¶V ikWoj IokbaV esa lHkh LykbZM~l dks ,d lkFk ns[kus esa fdldk iz;ksx gksxk\ 
A) View, Slide Sorter    B) View, Slide 
C) View, Master     D) View, Slide Show  
Ans : (A) 

20. izLrqrhdj.k esa tks LykbZM fo”k; dk ifjp; nsrh gS vkSj izLrqrhdj.k dk Vksu lsV djrh gS] dgykrh gS& 
A) Vscy LykbZM     B) xzkQ LykbZM 
C) cqysV LykbZM     D) VkbZVy LykbZM  
Ans : (D) 

21. fuEufyf[kr esa ls dkSu lk rkj&usVodZ ,d dk;kZy; ds vUnj gh fo|;eku jgrk gS\ 
A) LAN      B) WAN 
C) Cellular Network    D) MAN 
Ans : (A) 

22. ,Q-Vh-ih- fdlfy, iz;ksx gksrk gS\ 
A) fdlh nwjorhZ dEI;wVj ij QkbZy ns[kus ds fy,A B) Mksesu dk uke igpkuus ds fy,A 
C) gkWLV dk uke igpkuus ds fy,A   D) QkbZy dks usVodZ ij Hkstus ds fy,A 
Ans : (D) 

23. fuEufyf[kr esa ls dkSu lk dFku lR; gS\ 
A) Vhlhih@vkbZih ekWMy vks,lvkbZ ekWMy ls igys fodflr gqvkA 
B) Vhlhih@vkbZih ekWMy vks,lvkbZ ekWMy ds ckn fodflr gqvkA 
C) Vhlhih@vkbZih ekWMy vks,lvkbZ ekWMy ds lekUrj fodflr gqvkA 
D) Vhlhih@vkbZih ekWMy vks,lvkbZ ekWMy dh dfe;ksa dks nwj djus ds fy, fodflr gqvkA 
Ans : (A) 

24. fuEufyf[kr esa ls dkSu lk Vhlhih@vkbZih ekWMy esa VªkaliksVZ ys;j dk izksVksdkWy ugha gS\ 
A) Vh-lh-ih-      B) ;w-Mh-ih- 
C) ,Q-Vh-ih-      D) ,l-lh-Vh-ih- 
Ans : (D) 

25. Vhlhih@vkbZih fuEufyf[kr esa ls fdldk laf{kIr :Ik gS\ 
A) VªkalQj dUVªksy vkWQ th ,l ,e@bUVjusV izksVksdksYl 
B) VªsfM’kuy dUVªksy izksVksdksYl@bUVjusV izksVksdksYl 
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C) Vªkalfe’ku dusD’ku ijfe’ku@bUVjusV ijfe’ku 
D) Vªkalfe’ku dUVªksy izksVksdksy@bUVjusV izksVksdksy 
Ans : (D) 

26. MCY;w MCY;w MCY;w fuEufyf[kr esa ls fdldk laf{kIr :Ik gS\ 
A) oYMZ okbM osc     B) oYMZ okbM okWElZ 
C) oYMZ okbM osV     D) oYMZ okbM oksacy  
Ans : (A) 

27. blesa ls dkSu lk izksVksdksy osc ist dks viyksM djus ds fy, iz;ksx gksrk gS\ 
A) MCY;w MCY;w MCY;w     B) ,p Vh Vh ih 
C) ,Q Vh ih      D) vks ,l ih ,Q  
Ans : (C) 

28. ,p Vh ,e ,y fdldk laf{kIr :Ik gS\ 
A) gkbZij VsDLV fefuaxQqy ySaxost   B) gkbZij VsDlVqy eSftd ySaxost 
C) gkbZij VsDlVqy E;wftd ySaxost   D) gkbZij VsDlV ekdZvi ySaxost 
Ans : (D) 

29. blesa ls dkSu lh osc ist dh ,DlVsa’ku ugha gS\ 
A) ,p Vh ,e      B) , ,l ih 
C) ih ,p ih      D) vkj Vh ,Q 
Ans : (D) 

30. -------------------------- ,d oS/k Mksesu yscy ugha gSA 
A) com      B) coop 
C) ind      D) pro 
Ans : (B) 

31. ÝUV ist ,e-,l- vkWfQl dk iSdst gS] ;g D;k cukus ds dke vkrk gS\ 
A) ,Iyhds’ku izksxzkEl     B) osc istsl 
C) ok;jysl QkbZYl     D) LiszM’khV QkbZYl 
Ans : (B) 

32. bZ&dkWelZ fdldk laf{kIr :Ik gS\ 
A) ;wjks dkWelZ     B) ,DLVsfVd dkWelZ 
C) bySfDVªdy dkWelZ     D) bySDVªksfud dkWelZ 
Ans : (D) 

33. ,p-Vh-,e-,y- esa ,d v{kj dk Qklyk nsus ds fy, ----------------------- dk iz;ksx gksrk gSA 
A) <br>      B) &nbsp; 
C) <b>      D) <space> 
Ans : (B) 
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34. Qk;joky iz;ksx gksrk gS& 
A) ckgjh okrkZ ds pyrs vukf/kd`r izos’k dks jksdus ds fy,A 
B) flLVe ds lkFk bUVªsDV djus okys lHkh izdkj ds ;wtlZ dks jksdus ds fy,A 
C) flLVe dks vkx o xehZ ls ØS’k gksus dks jksdus ds fy,A 
D) flLVe esa vukf/kdr̀ izos’k dh vuqefr ds fy,A 
Ans : (A) 

35. fofM;ks dkWUÝsaflax blesa ls fdlds leku gS\ 
A) vkWfM;ks dkWUÝsaflax             B) fjdksfMaM Vsyhfotu Vªkalfe’ku 
C) ySaM ykbZu dkWUÝsaflax vkWu yksdy ch-,l-,u-,y- QksUl    D) fofM;ks VsyhdkWUÝsaflax 
Ans : (D) 

36. oh-ch- esa buesa ls dkSu lk ,d mfpr ckWDl ugha gS\ 
A) dkWEcks ckWDl     B) Mk;ykWx ckWDl 
C) fyLV ckWDl     D) bosUV ckWDl 
Ans : (D) 

37. dkSu lk rF; oh-ch- ds fglkc ls lgh gS\ 
A) jsfM;ks cVu esa cgqr lsysD’ku gks ldrh gS ij pSd&ckWDl esa dsoy ,d gh gksrh gSA 
B) jsfM;ks cVu esa dsoy ,d gh lsysD’ku gksrh gS ij pSd&ckWDl esa cgqr lh gks ldrh gSA 
C) jsfM;ks cVu vkSj pSd ckWDl nksuksa esa cgqr lh lsysD’ku gks ldrh gSA 
D) jsfM;ks cVu vkSj pSd ckWDl nksuksa esa dsoy ,d gh lsysD’ku gks ldrh gSA 
Ans : (B) 

38. Mh ,y ,y ls D;k vfHkizk; gS\ 
A) fMLVªhC;wfVM fyaDM fyLV    B) Mk;usfed fyaDM fyLV 
C) Mk;usfed fyaDM ykbZcszjh    D) Mk;jsfDVM ykWLV fyaDl 
Ans : (C) 

39. blesa ls dkSu lk ^,fDVo ,Dl dUVªksy* ugha gS\ 
A) List View     B) Text View 
C) Tree View     D) MAPI 
Ans : (B) 

40. MkVk jhihVj ,fDVo ,Dl dUVªksy D;k djrk gS\ 
A) MkVk ckÅaM ;wtj dUVªksy cukrk gS] tks fd iz;ksxh dks MkVk csl fjdkWMZ vkKk nsrk gSA 
B) buiqV ckÅaM ;wtj dUVªksy nsrk gS] tks fd iz;ksxh dks cgqr ls fjdkWMZ MkVkcsl esa Mkyus dh vkKk nsrk gSA 
C) MkVk ckÅaM ;wtj dUVªksy dks cukrk gS] tks fd iz;ksxh dks ,d gh ls MkVk dh cgqr lh dkWfi;k¡ cukus dh vuqefr  
    nsrk gSA 
D) buiqV ckÅaM ;wtj dUVªksy dks izLrqr djrk gS] tks fd iz;ksxh dks MkVkcsl esa cgqr ls fjdkWMZ dks ,d gh lh osY;w  

         esa cnyus dh vuqefr nsrk gSA 
Ans : (B) 
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41. oh-ch- esa MkVkcsl ls fuEufyf[kr esa ls fdlls tqM+ko ugha gksrk gS\ 
A) ,-Mh-vks-Mh-ch-     B) Mh-ch-vks- 
C) ,-Mh-vks-Mh-lh-     D) Mh-,-vks- 
Ans : (B) 

42. fuEufyf[kr esa ls dkSu lh iafDr oh-ch- esa bQ LVsVesaV ds ckjs esa mfpr ugha gS\ 
A) ;s ,aM bQ is lekIr gksuk pkfg,A   B) ,d bQ LVsVesaV ds vUnj nwljh LVsVesaV ugha gks ldrhA 
C) bldh ,Yl LVsVesaV gks Hkh ldrh gS vkSj ugha HkhA D) blesa cgqr lh daMh’kUl gks ldrh gSA 
Ans : (B) 

43. oh-ch- esa Mh-vkbZ-,e- fdl dke vkrk gS\ 
A) dqN ckWDl dk pedhykiu de djus ds fy,A  
B) osfj;scy dh eSeksjh ?kksf”kr djus vkSj eSeksjh fnyokus ds dke vkrk gSA 
C) osfj;scy }kjk yh xbZ eSeksjh dks u”V djus ds dke vkrk gSA 
D) dqN ckWfDlt dks ,d txg ls nwljs txg ij ys tkus ds dke vkrk gSA 
Ans : (B) 

44. blesa ls dkSu lk vkbZ-Mh-bZ- dk fgLlk ugha gS\ 
A) dkWM ,fMVj foUMks     B) izksiVhZt foUMks 
C) Qksje ys vkmV foUMks    D) tujy foUMks 
Ans : (D) 

45. oh-ch- esa ,fIyds’ku dk uke dgk¡ ij vkrk gS\ 
A) izksiVhZt foUMks     B) bUVjehfM;sV foUMks 
C) dkWM foUMks     D) VkbZVy ckj 
Ans : (D) 

46. oh-ch- esa dUVªksy D;k gS\ 
A) Code      B) Part of Menus 
C) Rules      D) Objects 
Ans : (D) 

47. oh-ch- ÝSaM ‘kCn dk D;k vFkZ gS\ 
A) ftl Dykl esa izksfltj cuk;k x;k gS] og mlh Dykl ds vUnj miyC/k djokrk gSA 
B) Dykl ds ,d izksfltj dks Dykl ds ckgj ds ekWM~;wYl dks miyC/k djokrk gS vkSj nwljh ,Iyhds’kUl ds ekWM~;wYl  
    esa Hkh miyC/k djokrk gSA 
C) Dykl ds ,d izksfltj dks Dykl ds ckgj okys ekWM~;wYl dks miyC/k djkrk gS] ij tks ekWM~;wYl leku ,Iyhds’ku  
    esa vkrs gSA 
D) Dykl ds ,d izksfltj dks bu&izkslsl dEiksusaV dks miyC/k djokrk gSA 
Ans : (C) 

48. ^lh* Hkk”kk esa dkSu lh ywi gS\ 
A) if else      B) switch case 
C) if than else     D) for 
Ans : (D) 
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49. fuEufyf[kr esa ls dkSu lk ^lh* Hkk”kk dk MkVk VkbZi ‘kCn ugha gS\ 
A) real      B) float 
C) double      D) int 
Ans : (A) 

50. dkSu lk fpUg ^lh* Hkk”kk dh LVsVesaV ds vUr esa vkrk gS\ 
A) Semicolon     B) Question mark 
C) Full stop      D) Comma 
Ans : (A) 

51. ^lh* izksxzke esa buesa ls dkSu lh dekaM ewY; fuos’k ds dke vkrh gS\ 
A) printf      B) scanf 
C) putc      D) insert 
Ans : (B) 

52. dkSu lk ykWftdy vkWijsVj ,Dlizs’ku dh VªwFk osY;w dks mYVk djrk gS\ 
A) &&      B) || 
C) !       D) & 
Ans : (C) 

53. dkSu lk ykWftdy vkWijsVj nks rF;ksa dks ,aM djrk gS\ 
A) &&      B) || 
C) !       D) & 
Ans : (A) 

54. dkSu lk fu/kkZfjr ‘kCn ^lh* Hkk”kk esa ¶yksfVax IokbaV ewY; ?kksf”kr djrk gS\ 
A) float      B) real 
C) integer      D) decimal 
Ans : (A) 

55. ^lh* Hkk”kk esa ^czsd* fdl dke vkrk gS\ 
A) izksxzke ls ckgj fudyus ds fy,A   B) bQ LVsVesaV ls ckgj fudyus ds fy,A 
C) QaD’ku esa ls fudyus ds fy,A   D) ywi esa ls fudyus ds fy,A 
Ans : (D) 

56. ywi ds ,DthD;w’ku esa ^Mw OgkbZy* vf/kdre fdlfy, iz;ksx gksrh gS\ 
A) dsoy ,d ckj ds fy,A    B) de ls de ,d ckj ds fy,A 
C) nks ckj ds fy,A     D) vuUr pyus ds fy,A 
Ans : (B) 

57. tc ^lh* Hkk”kk esa ,d QaD’ku vius dks ckj&ckj lhfer le; ds fy, iz;ksx djrk gS] rks mls D;k dgrs gS\ 
A) Array      B) Main 
C) Recursion     D) Constant Function 
Ans : (C) 

Suraku Academy     |     www.surakuacademy.com

Suraku Academy     |     www.surakuacademy.com

http://www.IA1302.COM
http://www.smarttypingsolution.com
http://www.dsguruji.com
http://www.dsguruji.com


  

                  IA 2008 Paper                        

 

                                        

58. ,d tSls MkVk VkbZi ewY;ksa ds laxzg dks ------------------------ dgrs gS\ 
A) Array      B) Main 
C) Recursion     D) Constant Values 
Ans : (A) 

59. gkbZ ysoy ^lh* Hkk”kk dks fdlus fodflr fd;k\ 
A) Msful ,e-fjph     B) fudykWl o`Fk 
C) lsekWj isiVZ      D) MksukYM dqaFk 
Ans : (A) 

60. ,e-,l- vkWfQl dk ,Dly izksxzke fdl dke vkrk gS\ 
A) MkVkcsl ds      B) LiszM’khV ds 
C) xzkQ ds      D) Åij fyf[kr lHkh ds 
Ans : (D) 

61. ,Dly ds lHkh lw= dgk¡ ls ‘kq: gksrs gS\ 
A) @      B) = 
C) +       D) % 
Ans : (B) 

62. ,Dly ‘khV esa pquk gqvk lSy fdlls n’kkZ;k tkrk gS\ 
A) xgjk pkSM+k fdukjk     B) fcUnqvksa ls cuk fdukjk 
C) pedrk gqvk fdukjk    D) Åij esa ls dksbZ ugha 
Ans : (C) 

63. ,e-,l- ,Dly esa pquk gqvk {ks= tks ch1 ls ‘kq: gksdj th dkWye dh ykbZu uEcj 10 rd tk;sxk] mls dSls fy[ksaxs\ 
A) B1-G10      B) B1.G10 
C) B1;G10      D) B1:G10 
Ans : (D) 

64. ,e-,l- ,Dly esa jksa vkSj dkWye ds foHkktu dks D;k dgsaxs\ 
A) data      B) a field 
C) a cell      D) an equation 
Ans : (C) 

65. odZ ‘khV esa gkbZij fyad ds fy, D;k djsaxs\ 
A) Alt + K      B) Ctrl + H 
C) Ctrl + K      D) Ctrl + Shift + K 
Ans : (C) 

66. ^D;wVhvkj 1] D;wVhvkj 2] D;wVhvkj 3* D;k n’kkZrk gS\ 
A) Formula      B) Function 
C) Series      D) Syntax 
Ans : (C) 
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67. buesa ls dkSu lk lgh fodYi ugha gS& tc ge ,e-,l- ,Dlsl esa u;k MkVkcsl cuk;saxs\ 
A) Create table in design view  B) Create table by using wizard 
C) Create table by entering data D) Create table by copying data from another file 
Ans : (B) 

68. ,e-,l- ,Dlsl ds MkVkcsl esa ikloMZ Mkyus ds fy, D;k djsaxs\ 
A) Insert → Security → Set database password 
B) Tools → Security → Set database password 
C) View → Security → Set database password 
D) buesa ls dksbZ ugha 
Ans : (B) 

69. ,e-,l- ,Dlsl esa Dosjh eksM esa tkus ds fy, D;k djsaxs\ 
A) O;w ij fDyd djsaxsA    B) balVZ ij fDyd djsaxsA 
C) VwYl ij fDyd djsaxsA    D) fo.Mks ij fDyd djsaxsA 
Ans : (B) 

70. ,l-D;w-,y- dh dkSu lh dekaM MkVk ns[kus ds dke vkrh gS\ 
A) View      B) Create 
C) Insert      D) Select 
Ans : (D) 
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